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Preface

This guide explains customization and extension of Oracle Banking Platform.

This preface contains the following topics:

n Audience

n Documentation Accessibility

n Related Documents

n Conventions

Audience
This guide is intended for the users of Oracle Banking Platform.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at
http://www.oracle.com/us/corporate/accessibility/index.html.

Access to Oracle Support

Oracle customers have access to electronic support throughMy Oracle Support. For information, visit
http://www.oracle.com/us/corporate/accessibility/support/index.html#info or visit
http://www.oracle.com/us/corporate/accessibility/support/index.html#trs if you are hearing impaired.

Related Documents
Formore information, see the following documentation:

n For installation and configuration information, see the Oracle Banking Platform Installation Guide -
Silent Installation.

n For a comprehensive overview of security, see the Oracle Banking Security Guide.

n For the complete list of licensed products and the third-party licenses included with the license, see the
Oracle Banking Licensing Guide.

n For information related to setting up a bank or a branch, and other operational and administrative
functions, see the Oracle Banking Administrator’s Guide.

n For information on the functionality and features, see the respective Oracle Banking Functional
Overview documents.

Conventions
The following text conventions are used in this document:
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Convention Meaning

boldface Boldface type indicates graphical user interface elements associated with an
action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for which you
supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code in
examples, text that appears on the screen, or text that you enter.
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1 About This Guide

This guide is applicable for the following products:

n Oracle Banking Platform (OBP)

n Oracle Banking Enterprise Product Manufacturing (OBEPM)

n Oracle Banking Enterprise Originations (OBEO)

n Oracle Banking Enterprise Collections (OBEC)

References to Oracle Banking Platform or OBP in this guide apply to all the abovementioned products. The
chapters and sections that are not applicable for any of the products are listed in this chapter.

1.1 Sections Not Applicable for Oracle Banking Enterprise
Product Manufacturing
The following chapters and sections in this guide are not applicable for Oracle Banking Enterprise Product
Manufacturing.

n Section 3.1.3 Print Receipt Functionality

1 About This Guide | 19
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2 Objective and Scope

This chapter defines the objective and scope of this document.

2.1 Overview
Oracle Banking Platform (OBP) is designed to help banks respond strategically to today’s business
challenges, while also transforming their business models and processes to reduce operating costs and
improve productivity across both front and back offices. It is a one-stop solution for a bank that seeks to
leverageOracle Fusion experience for its core banking operations, across its retail and corporate offerings.

OBP provides a unified yet scalable IT solution for a bank tomanage its data and end-to-end business
operations with an enriched user experience. It comprises pre-integrated enterprise applications leveraging
and relying on the underlying Oracle Technology Stack to help reduce in-house integration and testing efforts.

2.2 Objective and Scope
Most product development can be accomplished through highly flexible system parameters and business
rules. Further competitive differentiation can be achieved through IT configuration and extension support. In
OBP, additional business logic required for certain services is not always a part of the core product
functionality but could be a client requirement. For these purposes, extension points and customization
support have been provided in the application code which can be implemented by the bank and / or by
partners, wherein the existing business logic can be added with or overridden by customized business logic.
This way the time consuming activity of custom coding to enable region specific, site specific or bank specific
customizations can beminimized.

2.2.1 Extensibility Objective
The broad guiding principles with respect to providing extensibility in OBP are summarized below:

n Strategic intent for enabling customers and partners to extend the application.

n Internal development uses the same principles for client specific customizations.

n Localization packs

n Extensions by Oracle Consultants, Oracle Partners, Banks or Bank Partners.

n Extensions through the addition of new functionality or modification of existing functionality.

n Planned focus on this area of the application. Hence, separate budgets specifically for this.

n Standards based - OBP leverages standard tools and technology

n Leverage large development pool for standards based technology.

n Developer tool sets provided as part of JDeveloper and Eclipse for productivity.

2.2.2 Document Scope
The scope of this document is to explain the customization and extension of OBP for the following use cases:

2 Objective and Scope | 21



2.3 Complementary Artefacts

n Customizing OBP UI

n Adding an ADF screen side validation to an existing field

n Adding a new field or a table on the screen

n Removing fields from the UI

n Customizing OBP application services and implementing composite application services

n Adding pre-processing or post processing validations in the application services extension

n Altering the product behavior at customizations hooks provided as adapter calls in functional areas that
are prone to change (for example, loan schedule generation) and in betweenmodules that can be
replaced (for example, alerts, content management)

n Adding new fields to the OBP domainmodel and including it on the corresponding screen.

n Adding a new report

n Adding a new batch program

n Customizing SOA based BPEL process with adding a partner link or a human task to an existing
process.

n Adding new steps as a sub-process

n Adding or customizing facts and business rules in the application and configuring them for different
modules

n Adding or customizing ID generation logic with options of automated, manual or custom generation

n Processing of the uploaded files data

n Printing of receipt once the transaction is over

n Defining the security related access and authorization policies

n Defining different security related rules, validator and processing logics

n Customizing different functionalities like user search, role evaluation and limit exclusion in the
application related to security

This document is a useful tool for Oracle Consulting, bank IT and partners for customizing and extending the
product.

2.3 Complementary Artefacts
The document is a developer’s extensibility guide and does not intend to work as a replacement of the
functional or technical specification, which would be the primary resource covering the following:

n OBP Zen training course

n OBP installation and configuration

n OBP parameterization as part of implementation

n Functional solution and product user guide

References to plugin indicate the eclipse basedOBP development plugin for relevant version of OBP being
extended. The plugin is not a product GA artefact and is ameans to assist development. Hence, the same is
not covered under product support.
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2.4 Out of Scope

2.4 Out of Scope
The scope of extensibility does not intend to suggest that OBP is forward compatible.

2 Objective and Scope | 23
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3 Overview of Use Cases

The use cases that are covered in this document shall enable the developer in applying the discipline of
extensibility to OBP. While the overall support for customizations is complete in most respects, the same is
not a replacement for implementing a disciplined, thoughtful and well-designed approach towards
implementing extensions and customizations to the product.

3.1 Extensibility Use Cases
This section gives an overview of the extensibility topics and customization use cases to be covered in this
document. Each of these topics is detailed in the further sections.

3.1.1 ADF Screen Customization Using UI Extensions
In OBP, additional business logic or UI component changes might be required for certain ADF screen. This
additional logic is not part of the core product functionality, but could be a client requirement. For this purpose,
hooks have been provided in the application code wherein additional business logic can be added with custom
business logic.

Figure 3–1 ADF Screen Extensions

Note

Screen changes can be implemented using the UI extensions or ADF
Screen Customization. It is recommended to use the UI extensions
where possible as migration path to higher release of OBP is easier.

UI Extension:

3 Overview of Use Cases | 25



3.1 Extensibility Use Cases

This hook resides in the ADF taskflow. This hook is present before as well as after the actual UI event
execution. The additional business logic has to implement the interface I<taskflow_name>UIExt and extend
and override the default implementationVoid<taskflow_name>UIExt provided for the taskflow. Multiple
implementations can be defined for a particular taskflow. The UI extensions executor invokes all the
implementations defined for the particular taskflow both before and after the actual UI event execution.

3.1.2 ADF Screen Customization Using MDS
OBP applicationmay need to be customized for certain additional requirements. However, since these
additional requirements differ from client to client, and the base application functionality remains the same,
the code to handle the additional requirements is kept separate from the code of the base application. For this
purpose, Seeded Customizations (built using Oracle Meta-data Services framework) can be used to
customize an application.

When designing seeded customizations for an application, one or more customization layers need to be
specified. A customization layer is used to hold a set of customizations. A customization layer supports one
or more customization layer value which specifies the set of customizations to apply at runtime.

Figure 3–2 ADF Screen Customization

3.1.3 Print Receipt Functionality
OBP has many transaction screens in different modules where it is desired to print the receipt with different
details about the transaction. This functionality provides the print receipt button on the top right corner of the
screen which gets enabled on the completion of the transaction and can be used for printing of receipt of the
transaction details.
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3.1 Extensibility Use Cases

Figure 3–3 Print Receipt Functionality

3 Overview of Use Cases | 27
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4 OBP Extensibility Support Using Eclipse
Plugin

OBP Eclipse Plugin has been updated to support OBP Extensibility features like run-time inclusion of
Application Service SPI Extensions and Business Policy Extensions in the form of uploadable Groovy files.

4.1 Configure Eclipse Preferences for OBP Service Plugin
1. Click onWindows > Preferences.

Figure 4–1 Java Eclipse - Select Preferences

4 OBP Extensibility Support Using Eclipse Plugin | 29



4.1 Configure Eclipse Preferences for OBP Service Plugin

Figure 4–2 Preferences Dialog Box - OBP Service Plugin
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4.1 Configure Eclipse Preferences for OBP Service Plugin

Figure 4–3 Folder Selection

2. The parameter “Temporary Project” has to be configured to point to the base project where the Groovy
Extension Files have to be saved.

4 OBP Extensibility Support Using Eclipse Plugin | 31



4.1 Configure Eclipse Preferences for OBP Service Plugin

Figure 4–4 Browse For Folder

3. The parameter “MWLib Path” has to be configured to point to the directory where all the OBP Host jar
files have been kept.
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4.2 Support for UI Extension

Figure 4–5 Configuring MWLib Path Parameter

4. The rest of the OBP Service Plugin parameters can be configured as usual.

4.2 Support for UI Extension

4.2.1 Generate UI Extension
The parameter “Temporary Project” has been configured to point to the base project where the Groovy
Extension Files have to be saved. The parameter “MWLib Path” has to be configured to point to the directory
where all the OBP Host jar files have been kept. Here we have to place all jar files in “obp.ui.domain” deployed
in UI Server. Also it is mandatory to place adfm.jar; adf-richclient-api-11.jar and javax.faces.jsf-api.jar
available in JDeveloper 12C Installation Location.
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4.2 Support for UI Extension

1. Right click on this project and select Oracle Banking Platform > Generate UI Extension.

Figure 4–6 Generate UI Extension
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4.2 Support for UI Extension

Figure 4–7 UI Extension Configuration

The above wizard appears with a list of Base UI Files.

2. Enter a search keyword to filter the list for the required Base UI file.

4 OBP Extensibility Support Using Eclipse Plugin | 35



4.2 Support for UI Extension

Figure 4–8 UI Extension Configuration - Search for Base UI File

3. Select the filtered Base UI file from the list such that it appears as the input for Base UI file.
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4.2 Support for UI Extension

Figure 4–9 UI Extension Configuration - Base UI File Selected

4. Appropriately set values for the Extension Class Name and package.

4 OBP Extensibility Support Using Eclipse Plugin | 37



4.2 Support for UI Extension

Figure 4–10 UI Extension Configuration - Class Name and Package

5. Click on “Generate Extension Code”.
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4.2 Support for UI Extension

Figure 4–11 UI Extension Configuration - Generate Extension Code

The code gets generated with the extension hooks.

4 OBP Extensibility Support Using Eclipse Plugin | 39



4.2 Support for UI Extension

Figure 4–12 UI Extension Configuration - Code Generated with Extension Hooks

6. Click on “Save Extension” and “Finish”.
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4.2 Support for UI Extension

Figure 4–13 Project - UI Extension Created

The extension gets saved in the project created to contain the Extension classes generated through
the plugin. We can add all the code required in the pre and post hooks for extensibility of the base UI
File.
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4.2 Support for UI Extension

4.2.2 Configure OBP Extensibility Server Explorer - View
1. In eclipse click onWindow > Show View > Other.

Figure 4–14 Configuring OBP Extensibility Server Explorer

2. Click onOracle Banking Platform > Server Explorer.
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4.2 Support for UI Extension

Figure 4–15 Create Server Explorer

The “ServerExplorer” view tab opens up.
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4.2 Support for UI Extension

Figure 4–16 Server Explorer View tab

3. Right click on Server Explorer and click “Create Server Connection”.
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4.2 Support for UI Extension

Figure 4–17 Server Explorer - Create Server Connection

4. Provide values for Connection, name, ip, and port, and test connection and click OK.
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4.2 Support for UI Extension

Figure 4–18 Server Connection Configuration

The configured server appears as a child of “Server Explorer”. The configured server also lists all
Application Service SPI Extensions and all Business Policy Extensions and all Adapter Extensions
and all UI Extensions already deployed in server.
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Figure 4–19 Server Configured
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4.2.3 Exposed Webservice for UI Extensions

Figure 4–20 ExtensionApplicationServiceSpi Web Service for UI Extensions

“ExtensionApplicationServiceSpi” is the web service that exposes the web services to add UI extensions,
fetch UI extensions and delete UI extensions. These services are used by the eclipse plugin to deploy
extensions, fetch extensions and undeploy extensions at runtime.

4.2.4 Deploy UI Extension to Server
1. Right Click on the Extension Class in the Package Explorer or the Code Editor and click onOracle

Banking Platform > Deploy UI Extension To Server.
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Figure 4–21 Deploy UI Extension to Server

2. It is compulsory to have selected the Server under “Server Explorer” in which the deployment has to
occur.
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Figure 4–22 Select Server Explorer to Deploy UI Extension

The Extension gets deployed in the server.

3. The Extension gets deployed in the server and appears under the appropriate child of Server configured
under “Server Explorer”.
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Figure 4–23 UI Extensions Deployed to Server Explorer
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4.2.5 Database Inserts: UI Extension Deployment

Figure 4–24 Single Record View - UI Extension Deployment
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Figure 4–25 Single Record View - UI Extension Deployment
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Figure 4–26 View Value - UI Extension Deployment
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Figure 4–27 Single Record View - UI Extension Deployment

4.2.6 Fetching Deployed UI Extension
1. For the purpose of fetching a deployed Extension from the Server, we can click on the appropriate

Extension under the appropriate child under “Server Explorer”.
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Figure 4–28 Fetch Deployed UI Extension

2. The extension gets saved in the project created to contain the Extension classes generated through
the plugin. Also the Extension code opens up in the Code Editor.
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Figure 4–29 Extension Saved in Project

4.2.7 Undeploying UI Extension
1. For the purpose of undeploying the Extension from the Server, we right click on the specific Extension

under the appropriate child of the Server configured under “Server Explorer”.
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Figure 4–30 Undeploy UI Extension from Server

2. The specific Extension under the appropriate child of the Server configured under “Server Explorer”
disappears and gets undeployed from the Server.
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Figure 4–31 UI Extension Undeployed

4.2.8 Case of Multiple UI Extensions
We can choose to addmultiple Groovy extensions for the sameUI Base File. These will appear in the order in
which they were added under Server Explorer > Server > Service Provider Extensions.
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Figure 4–32 Multiple UI Extensions

4.2.9 Inclusion of Groovy Extension in Actual Code Flow
Changes have been included in UIExtensionFactory.java to fetch the Groovy Class from aMap that gets
populated after a defined interval in a Singleton.

Figure 4–33 UIExtensionFactory.java
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UIGroovyExtensions is a singleton class that runs as a TimerTask to fetch all UIExtensions deployed in the
Host Server and populates amapwith the Groovy Classes. This gets accessed by the
UIExtensionFactory.java above.

Figure 4–34 UIGroovyExtensions
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5 ADF Screen Customizations Using UI
Extensions

This chapter describes how additional business logic can be added prior to (pre hook) and / or post the
execution (post hook) of a particular UI event business logic on the UI side. Extension prior to a UI event
executionmay be required for the purposes of additional input validation, input manipulation, custom logging,
and so on. A few examples in which the UI extensions in the form of pre and post hook are required are
mentioned below.

A UI extension in the form of a pre hook can be important in the following scenarios:

n Additional input validations

n Execution of business logic, which necessarily has to happen before going ahead with normal event
execution

n Request manipulation prior to making host call

A UI extension in the form of a post hook can be important in the following scenarios:

n Output responsemanipulation

n Custom UI components rendering, changing to read only
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Figure 5–1 UI Extension Pre Hook and Post Hook Taskflow

The pre hook is provided after the invocation of UIevent call inside the Abstract Taskflow Handler. The
extensionmethod is provided with the ADF event and the Taskflow Handler Instance as parameters. The
handler instancemay be required in such cases where the VO attributes or the UI components need to be
accessed as a part of the customization.

The post hook is provided after the event business logic. Similar parameters are provided in the post
extension. Hooks are provided in handler and assembler methods, for taskflows using the Integrable
Taskflow framework. Hooks are provided in backing beanmethods for all other taskflows.

64 | Oracle Banking Platform UI Extensibility Guide



5.1 UI Extension Interface

Figure 5–2 Save Method in IntegrableTaskflowHelper

For taskflows implementing the ADF Integrable Taskflow Framework, the pre and post hooks are provided for
the common Integrable taskflow helper methods. Refer to the above sequence diagram for the Savemethod
in IntegrableTaskflowHelper.

The following sections detail the important concepts which should be understood for extending in this UI
layer.

5.1 UI Extension Interface
TheOBP ADF Taskflow Generator generates an interface for the extensions of a particular taskflow. The
interface name is of the form I<Taskflow_Name>UIExt. This interface has a pair of pre and post method
definitions for each public method present in the Abstract Taskflow Handler and the Integrable Taskflow
Helper. The signatures of thesemethods are:

public void pre<Method_Name>(<Method_Parameters>) throws
FatalException;
public void post<Method_Name>(<Method_Parameters>) throws
FatalException;

A single method is provided for Integrable Assembler. The signature as below:

public void assembler<Method_Name>(<Method_Parameters>) throws
FatalException;

A UI extension class has to implement this interface. The premethod of the extension is executed before the
actual method and the post method of the extension is executed after themethod.

The return type for certain methods are boolean (for example, public boolean preValidateData).
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5.2 Default UI Extension

Figure 5–3 Example of UI Extension

5.2 Default UI Extension
TheOBP plug-in generates a default extension for a particular taskflow in the form of the class
Void<Taskflow_Name>UIExt. This class implements the aforementioned UI extension interface without
any business logic, that is, the implementedmethods are empty.

The default extension is a useful and convenient mechanism to implement the pre and / or post extension
hooks for specific methods of a taskflow. Instead of implementing the entire interface, one should extend the
default extension class and override only the requiredmethods with the additional business logic. Product
developers DONOT implement any logic, including product extension logic, inside the default extension
classes. This is because the classes are auto-generated, reserved for product use, and get overwritten as a
part of a bulk generation process.
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5.3 UI Extension Executor

Figure 5–4 Example of Default UI Extension

5.3 UI Extension Executor
TheOBP plug-in for Eclipse generates a UI extension executor interface and an implementation for the
executor interface. The naming convention for the generated executor classes which enable "extension
chaining" is shown below:

Interface : I<Taskflow_Name>UIExtExecutor
Implementation : < Taskflow_Name >UIExtExecutor

The UI extension executor class, on load, creates an instance each of all the extensions defined in the UI
extensions configuration. If no extensions are defined for a particular service, the executor creates an
instance of the default extension for the taskflow. The executor also has a pair of pre and post methods for
eachmethod. Thesemethods in turn call the correspondingmethods of all the extension classes defined for
the taskflow.
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5.3 UI Extension Executor

Figure 5–5 UI Extension Executor Class Taskflow
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5.3 UI Extension Executor

Figure 5–6 Example of UI Extension Executor Class
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5.4 Extension Configuration

Figure 5–7 Example of UI Extension Executor Class

5.4 Extension Configuration
The extension classes that implement the extension interface aremapped to the taskflow with the help of
seed data in FLX_FW_CONFIG_ALL_B.

Following is a sample implementation.

Single Extension Class

insert into
FLX_FW_CONFIG_ALL_B(CATEGORY_ID,PROP_ID,PROP_VALUE,PROP_
COMMENTS,OBJECT_VERSION_NUMBER,CREATED_BY,CREATION_DATE,LAST_
UPDATED_BY,LAST_UPDATED_DATE,OBJECT_STATUS_FLAG,FACTORY_SHIPPED_
FLAG)
values
('UIExtensions','com.ofss.fc.ui.taskflows.account.accountholderpre
ferencesetup.view.backing.AccountHolderPreferenceSetup','com.ofss.
fc.lz.au.ui.taskflows.account.accountholderpreferencesetup.view.ex
t.RegionalAccountHolderPreferenceSetupUIExt','',1,'ofssuser',SYSDA
TE,'ofssuser',SYSDATE,'A','y');

Multiple Extension Classes

insert into
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FLX_FW_CONFIG_ALL_B(CATEGORY_ID,PROP_ID,PROP_VALUE,PROP_
COMMENTS,OBJECT_VERSION_NUMBER,CREATED_BY,CREATION_DATE,LAST_
UPDATED_BY,LAST_UPDATED_DATE,OBJECT_STATUS_FLAG,FACTORY_SHIPPED_
FLAG)
values
('UIExtensions','com.ofss.fc.ui.taskflows.account.accountholderpre
ferencesetup.view.backing.AccountHolderPreferenceSetup','com.ofss.
fc.lz.au.ui.taskflows.account.accountholderpreferencesetup.view.ex
t.RegionalAccountHolderPreferenceSetupUIExt','',1,'ofssuser',SYSDA
TE,'ofssuser',SYSDATE,'A','y');
insert into
FLX_FW_CONFIG_ALL_B(CATEGORY_ID,PROP_ID,PROP_VALUE,PROP_
COMMENTS,OBJECT_VERSION_NUMBER,CREATED_BY,CREATION_DATE,LAST_
UPDATED_BY,LAST_UPDATED_DATE,OBJECT_STATUS_FLAG,FACTORY_SHIPPED_
FLAG)
values
('UIExtensions','com.ofss.fc.ui.taskflows.account.accountholderpre
ferencesetup.view.backing.AccountHolderPreferenceSetup','com.ofss.
fc.lz.au.ui.taskflows.account.accountholderpreferencesetup.view.ex
t.RegionalAccountHolderPreferenceSetupUIExtForUseCase1','',1,'ofss
user',SYSDATE,'ofssuser',SYSDATE,'A','y');
insert into
FLX_FW_CONFIG_ALL_B(CATEGORY_ID,PROP_ID,PROP_VALUE,PROP_
COMMENTS,OBJECT_VERSION_NUMBER,CREATED_BY,CREATION_DATE,LAST_
UPDATED_BY,LAST_UPDATED_DATE,OBJECT_STATUS_FLAG,FACTORY_SHIPPED_
FLAG)
values
('UIExtensions','com.ofss.fc.ui.taskflows.account.accountholderpre
ferencesetup.view.backing.AccountHolderPreferenceSetup','com.ofss.
fc.lz.au.ui.taskflows.account.accountholderpreferencesetup.view.ex
t.RegionalAccountHolderPreferenceSetupUIExtForUseCase2','',1,'ofss
user',SYSDATE,'ofssuser',SYSDATE,'A','y');

It is possible to configuremultiple implementations of pre or post extensions for a taskflow in this layer. This
is achieved with the help of the extension executor. It has the capability to loop through a set of extension
implementations, which conform to the extension interface supported by the taskflow.

5.5 Customization Examples
Following are some examples of customization.

5.5.1 Replacing skin
Colours aremaintained as a variable in the css lib files of the respectivemodules. Skin can be replaced to
change the colours.

Replace skin: inside preCustomBranding()

@Override

public void preCustomBranding(Mainmain) {
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/*setting skin */

FacesContext fc = FacesContext.getCurrentInstance();

ELContext elc = fc.getELContext();

String skinId = "skyros";

ExpressionFactory exprFact = fc.getApplication().getExpressionFactory();

ValueExpression ve = exprFact.createValueExpression(elc, "#{sessionScope.skinFamily}", Object.class);

ve.setValue(elc, skinId);

/* setting fonts */

main.setFontPath("/css/lato.css");

/* set this flag to false so as to execute pre hook only once whenmain is loaded */

ELHandler.set("#{pageFlowScope.isCustomBranding}","false");

super.preCustomBranding(main);

}

Figure 5–8 Replacing skin

Figure 5–9 Replacing skin
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Figure 5–10 Example: Replacing skin

5.5.2 Changing the logo in the branding bar
Given themulti-brand nature, the ability is provided to display appropriate brand in OBP. For example,
Westpac, St George, Bank SA & Bank of Melbourne. Logos are given in the jspx/jsff files in the current code
'Oracle' logo is maintained in ''main.jspx" file. To replace a logo, refer to the following screen shot.

Figure 5–11 Replacing the logo

5.5.3 Modifying fonts
Font-family is maintained as a variable and inherited the variable in themixins which are used to style the
various ADF components. Hence if changed the variable's value font will change.

Variable for href to bemaintained in backing bean and this variable will be overridden in customization.

Example:

Main.jspx has a placeholder:

href="${pageContext.request.contextPath}${Main.fontPath}"
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Main.java holds the path of variable

private String fontPath = "/css/roboto.css";

5.5.4 Modifying images
Images aremaintained in the jsff as well as in css files.

Many ADF components provide provisions to give icons for different states of the components.

Example: set the icon and hover icon attribute

Figure 5–12 Example: To modify images

this.getButtonAdd().setIcon("/images/common/search/search_16_ena.png");

this.getButtonAdd().setHoverIcon("/images/common/search/search_16_ena.png");

Also wherever component's image can be replaced using css by applying it to the particular selector if
component exposes the selector. Same as graphics.

5.5.5 Graphics
Graphics include buttons, warnings, and so on.

Button styles aremaintained in the respective css files. (Handled through Section 5.5.1 Replacing skin)

Warning text is maintained in the resource bundle (". properties") files: Replace the properties file in
config/resources/taskflows/module

SamplePath : config/resources/taskflows/BankPolicyDefinition_en.properties

5.5.6 Adding a simple field to a product screen
Example: Adding input text to a panel form layout

/* create component and set relevant properties */

RichInputText ui = new RichInputText();

ui.setId("rit1");

ui.setLabel("Input text");

ui.setValue("Hello");

ui.setContentStyle("font-weight:bold;color:red");

/*add the newly created component to existing form */
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this.getPfl1().getChildren().add(ui);

Figure 5–13 Example: To add a simple field to a product screen

5.5.7 Adding a complex field popup to a product screen (popup, table,
tree, region, tf)
/*Handle via makingmds changes*/

5.5.8 Removing an existing field from a product screen
Example: Hiding an LOV from panel form layout

this.getBankCodeLOV().setVisible(false);

Figure 5–14 Example: To remove an existing field from a region

5.5.9 Making certain product optional product fields mandatory or
optional
Example: Setting bank name to required

this.getBankName().setRequired(true);

5.5.10 Adding a new column to an existing product grid
Example: Adding a new column to a table in CS26

/* create new column component */

RichColumn ui1 = new RichColumn();

ui1.setHeaderText("ColumnNew");

ui1.setId("col3");

ui1.setAlign("center");

ui1.setRowHeader("unstyled");

/* get the table from bindings where column needs to be added */
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getT1().getChildren().add(ui1);

AdfFacesContext.getCurrentInstance().addPartialTarget(getT1());

/* set the value in column 3 as required on any event */

RichInputText ui11 = new RichInputText();

ui11.setId("rit1");

ui11.setLabel("Input text");

ui11.setValue("Hello");

ui11.setContentStyle("font-weight:bold;color:red");

ui11.setReadOnly(false);

getT1().getChildren().get(3).getId();

getT1().getRowIndex();

getT1().getChildren().get(3).getChildren().add(ui11);

AdfFacesContext.getCurrentInstance().addPartialTarget(getT1());

Figure 5–15 Example: To add a new column to an existing prouct grid

5.5.11 Hiding columns from an existing product grid
Example: Hiding an existing column from a table in CS26

/* get the corresponding column and set its rendered property to false */

this.getT1().getChildren().get(1).setRendered(false);
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Figure 5–16 Example: To hide columns from an existing product grid

5.5.12 Graying out certain columns from an existing product grid
/* disabling the component that was set inside the column */

this. ui11.setDisabled(true);

5.5.13 Modifying properties of product table (rows or tablesummary)
this.getT1().setEmptyText("NewText");

in case where properties are picked up via RB the file itself can be replaced in customization

Figure 5–17 Example: To modify the properties of product table

5.5.14 Adding a new section to an existing product screen
/* create a new panel form layout */

RichPanelFormLayout pfl111 = new RichPanelFormLayout();

pfl111.setId("pfl111");

pfl111.setMaxColumns(2);

pfl111.setRows(1);

pfl111.setFieldWidth("60%");

pfl111.setLabelWidth("40%");

getPb1().getChildren().add(pfl111);

AdfFacesContext.getCurrentInstance().addPartialTarget(getPb1());
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/* create components to be added to that section */

RichInputText ui = new RichInputText();

ui.setId("rit1");

ui.setLabel("Input text");

ui.setValue("Hello");

ui.setContentStyle("font-weight:bold;color:red");

getPfl1().getChildren().add(ui);

AdfFacesContext.getCurrentInstance().addPartialTarget(getPfl1());

RichCommandButton ui2 = new RichCommandButton();

ui2.setId("ch1");

ui2.setText("Button");

ui2.setInlineStyle("font-weight:bold;");

ui2.setIcon("/images/common/search/search_16_ena.png");

ui2.setIcon("/images/common/print/printreciept_16_ena.png");

/*add new components to the new section */

getPb1().getChildren().get(2).getChildren().add(ui2);

getPb1().getChildren().get(2).getChildren().add(ui);

Figure 5–18 Example: To add a new section to an existing product screen

5.5.15 Hiding a section from a product screen
/* Hiding all components inside the panel form layout */

this.getPfl1().setVisible(false);

5.5.16 Adding a new tab to an existing product screen made of tabs
/* create a new tab and add its relevant properties */
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RichCommandNavigationItem ui2 = new RichCommandNavigationItem();

ui2.setId("newTab");

ui2.setSelected(false);

ui2.setText("newTab");

/* add it to the navigation pane */

this.getNp1().getChildren().add(ui2);

Figure 5–19 Example: To add a new tab to existing product screen made of tabs

5.5.17 Hiding a tab from a product screen made of multiple tabs
this.getNp1().getChildren().get(1).setRendered(false);

Figure 5–20 Example: To hide a tab from a product screen made of multiple tabs

5.5.18 Adding new buttons or links
This approach will not work for "Approvals" and "UI level security"

/* Create a new command button and set its relevant properties*/

RichCommandButton ui2 = new RichCommandButton();

ui2.setId("ch1");

ui2.setText("Button");

ui2.setInlineStyle("font-weight:bold;");

ui2.setIcon("/images/common/search/search_16_ena.png");
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/* add it to the relevant panel component */

this.getPfl1().getChildren().add(ui2);

AdfFacesContext.getCurrentInstance().addPartialTarget(getPfl1());

Figure 5–21 Example: To add new buttons or links

5.5.19 Overriding / Customizing the product behaviour on certain actions
like button clicks or tab-outs
/* need to create a new link programmatically and link the action listener method to it */

5.5.20 Overriding the product validation pattern
this.getPolicyName().setPattern("[a-zA-Z]*");

Figure 5–22 Example: To override the product validation pattern

5.5.21 Overriding the product lengths (min/max)
this.getPolicyName().setMaxLength("10");

5.5.22 Disable / Enable certain product fields
this.getBankName().setDisabled(true);

5.5.23 Change certain product fields to read-only either on load or based
on certain conditions
this.getBankName().setReadOnly(true);

5.5.24 Change label of existing product fields
this.getBankName().setValue("BankName");
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5.5.25 DC validation
The text for error message comes from "CommonValidationMessages_en.properties" and this file can be
replaced in customization. However the values for Min andMax length inside themessage can be overridden.

5.6 Using the JSFF Utils

5.6.1 How to Use JSFF Utils
Following is the example to use JSFFUtils:

JSFUtils.insertPanelHeader
("rphRomanianDetails","Details",parentId,uiComponent);
JSFUtils.insertRichPanelFormLayoutEnd
("rpfRomanian1","60%","40%",2,1,"rphRomanianDetails",uiComponent);

Figure 5–23 Example of JSFF Utils

5.6.2 Sample JSFF Utils Code Snippet
/**
*This method adds af:PanelFormLayout ADF component at the end of
the given parent.
* @param id sets id attribute on the af:PanelFormLayout.Type
String.
* @param fieldWidth sets fieldWidth attribute on the
af:PanelFormLayout.Type String.
* @param labelWidth sets labelWidth attribute on the
af:PanelFormLayout.Type String.
* @param maxColumns sets maxColumns attribute on the
af:PanelFormLayout.Type integer.
* @param row sets row attribute on the af:PanelFormLayout.Type
integer.
* @param parentId is the id of the immediate parent component where
af:PanelFormLayout need to be appended.Type String
* @param superParent is the component where parentId is placed.Type
UIComponent
*/
public static void insertRichPanelFormLayoutEnd(String id,String
fieldWidth, String labelWidth, int maxColumns,int row, String
parentId, UIComponent superParent) {
UIComponent uiComponentPGL = superParent.findComponent(parentId);
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RichPanelFormLayout richPanelFormLayout = new RichPanelFormLayout
();
richPanelFormLayout.setId(id);
richPanelFormLayout.setFieldWidth(fieldWidth);
richPanelFormLayout.setLabelWidth(labelWidth);
richPanelFormLayout.setMaxColumns(maxColumns);
richPanelFormLayout.setRows(row);
uiComponentPGL.getChildren().add(richPanelFormLayout);
}
*This method adds af:panelHeader ADF component at the end of the
given parent.
* @param id sets id attribute on the af:panelHeader.Type String.
* @param text sets text attribute on the af:panelHeader.Type
String.
* @param parentId is the id of the immediate parent component where
af:panelHeader need to be appended.Type String
* @param superParent is the component where parentId is placed.Type
UIComponent
*/
public static void insertPanelHeader(String id,String text,String
parentId,UIComponent superParent){
UIComponent uiComponentParent = superParent.findComponent
(parentId);
RichPanelHeader richPanelHeader = new RichPanelHeader();
richPanelHeader.setId(id);
richPanelHeader.setText(text);
uiComponentParent.getChildren().add(richPanelHeader);
}
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OBP provides the extensibility to an application for customizing certain additional requirements of a client.
However, since these additional requirements differ from client to client, and the base application functionality
remains the same, the code to handle the additional requirements should be kept separate from the code of
the base application. For this purpose, Seeded Customizations (built on the Oracle Metadata Services
framework) can be used to customize an application.

Note

It is recommended to use ADF screen extensions for UI changes
instead of mds where ever possible as it is easier to upgrade to new
version of product.

6.1 Seeded Customization Concepts
When designing seeded customizations for an application, one or more customization layers need to be
specified. A customization layer is used to hold a set of customizations. A customization layer supports one
or more customization layer value which specifies which set of customizations to apply at runtime.

Custom Application View can be represented as follows:

Figure 6–1 Customization Application View

Oracle JDeveloper 11g includes a special role for designing customizations for each customization layer and
layer value called the Customization Developer Role.

The following section explains the details about the Oracle JDeveloper customizationmode as well as
customizing and extending of the ADF application artifact. The detailed documentation for customizing and
extending ADF Application Artifacts is also available at the Oracle website:

http://docs.oracle.com/cd/E25178_01/fusionapps.1111/e16691/ext_busobjedit.htm
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6.2 Customization Layer

6.2 Customization Layer
To customize an application, youmust specify the customization layers and their values in the
CustomizationLayerValues.xml file, so that they are recognized by JDeveloper.

For example, you can create a customization layer with the name option and values demo and another bank
name.

To create the customization layer, follow these steps:

1. From themainmenu, choose the File -> Open option. Locate and open the file
CustomizationLayerValues.xml which is found in the <JDEVELOPER_HOME>/jdeveloper/jdev
directory. In the XML editor, add the entry for a new customization layer and values as shown in the
following image.

Figure 6–2 CustomizationLayerValues.xml

2. Save and close the file.

6.3 Customization Class
Before customizing an application, a customization class needs to be created. This class represents the
interface that theOracle Metadata Services framework uses to identify the customization layer that should be
applied to the application's basemetadata.

To create a customization class, follow these steps:
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1. From themainmenu, choose File -> New.

2. Create a generic project and give a name (com.ofss.fc.demo.ui.OptionCC) to the project.

3. Go toProject Properties for this project and add the requiredMDS libraries in the classpath of the
project.

Figure 6–3 Customization Class

4. Create the customization class in this project. The customization classmust extend the
oracle.mds.cust.CustomizationClass abstract class.

Following are the abstract methods of the CustomizationClass:

n getCacheHint() - This method will return the information about whether the customization layer
is applicable to all users, a set of users, a specific HTTP request or a single user.

n getName() - This method will return the name of the customization layer.

n getValue() - This method will return the customization layer value at runtime.

The screenshot below depicts an implementation for themethods:
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Figure 6–4 Implementation for the abstract methods of CustomizationClass

5. Build this class and deploy the project as a JAR file (com.ofss.fc.demo.ui.OptionCC.jar). This JAR file
should only contain the customization class.

6. Place this JAR file in the location <JDEVELOPER_HOME>/jdeveloper/jdev/lib/patches so that the
customization class is available in the classpath of JDeveloper.

6.4 Enabling Application for Seeded Customization
Seeded customization of an application is the process of taking a generalized application andmaking
modifications to suit the needs of a particular group. The generalized application first needs to be enabled for
seeded customization before any customizations can be done on the application.

To enable seeded customization for the application, follow these steps:

1. Go to theProject Properties of the application's project.

2. In theADF Views section, check theEnable Seeded Customizations option.
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Figure 6–5 Enable Seeded Customizations

3. In the Libraries and Classpath section, add the previously deployed com.ofss.fc.demo.ui.OptionCC.jar
which contains the customization class.

Figure 6–6 Adding com.ofss.fc.demo.ui.OptionCC.jar
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4. In the Application Resources tab, open the adf-config.xml present in the Descriptors/ADFMETA-INF
folder. In the list of Customization Classes, remove all the entries and add the
com.ofss.fc.demo.ui.OptionCC.OptionCC class to this list.

Figure 6–7 Adding com.ofss.fc.demo.ui.OptionCC.OptionCC

Figure 6–8 Adf-config.xml
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6.5 Customization Project
After creating the Customization Layer and the Customization Class and enabling the application for Seeded
Customizations, the next step is to create a project which will hold the customizations for the application.

To create the customization project, follow these steps:

1. From themainmenu, choose File -> New. Create a new Web Project with the following technologies:

n ADF Business Components

n Java

n JSF

n JSP and Servlets

2. Go to theProject Properties of the project and in the classpath of the project, add the following jars:

n Customization class JAR (com.ofss.fc.demo.ui.OptionCC.jar)

n The project JAR which contains the screen / component to be customized. For example, if you
want to customize theParty -> Contact Information -> Contact Point screen, the related project
JAR is com.ofss.fc.ui.view.party.jar.

n All the dependent JARS / libraries for the project JAR.

n Enable this project forSeeded Customizations.

6.6 Customization Role and Context
Oracle JDeveloper 11g includes a specific role called Customization Developer Role that is used for editing
seeded customizations.

To edit customizations to an application, you will need to switch JDeveloper to that role, follow these steps:
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1. In Tools > Preferences > Roles, select the Customization Developer Role.

Figure 6–9 Customization Developer

2. Select the "Always prompt for role selection on start up" option.
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Figure 6–10 Selecting Always Prompt for Role Selection on Start Up

3. On restarting JDeveloper, you will be prompted for role selection. Select Customization Developer
Role.

4. OnceOracle JDeveloper 11g has restarted, ensure that the application to be customized is selected in
the Application Navigator and have a look around the integrated development environment. You will
notice a few changes from the Default Role. The first change youmight notice is that files (such as
Java classes), that are not customizable, are now read only. The Customization Developer Role can
only be used for editing seeded customizations. Anything that is not related to seeded customizations
will be disabled. The secondmajor difference youmight notice is theMDS - Customization Context
window that is displayed.

5. Check theEdit with following Customization Context option. You will see a list of customization layer
name and customization layer values which were defined in theCustomizationLayerValues.xml file.

6. Select the Customization Context for which, the customizations you edit should be applicable.
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Figure 6–11 View Customization Context

All the customizations which are done to the application are now stored for the selected Customization
Context.

6.7 Customization Layer Use Cases

6.7.1 Adding a UI Table Component to the Screen
This second example of customization, explains adding a tableUI Component, which displays data to a
screen.

Use Case Description: The Advanced Search screen is used to display the related accounts and their
details for a party. TheParty -> On-Boarding -> Related Party screen displays the related parties for a party.
This section explains adding the table UI component used for displaying the related parties on theRelated
Party screen to theAdvanced Search screen and populate data in this table on search and selection of a
party.
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Figure 6–12 Adding a UI Table Component - Party Search screen

Figure 6–13 Adding a UI Table Component - Related Party screen

To create the customization as mentioned in this use case, start JDeveloper in theDefault Role and follow
these steps:

Step 1 Create Customization Project
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1. As mentioned in the sectionCustomization Project, create a project
(com.ofss.fc.demo.ui.view.party) to hold the customization.

2. Add the required libraries and JARS along with JAR which contains the above screen
(com.ofss.fc.ui.view.party.jar).

3. Enable the project for seeded customizations.

Step 2 Create Binding Bean Class
Youwill need to create a class which will contain the binding for theUI Components which will be added to
the screen during customization. Create the class with the following features:

n Privatemembers for the UI Components and public accessors for the same.

n Privatemember for the backing bean of the screen (PartySearchMaintenance)which is initialized in the
constructor of this class.

n Privatemember for the parent UI Component of the newly added UI components and public accessors
which returns the corresponding component of the backing bean.

Figure 6–14 Creating Binding Bean Class

Step 3 Create Event Consumer Class
Youwill need to create a class which contains the business logic for populating the table UI component with
the related parties’ data. The search and selection of a party in theAdvanced Search screen raises an event.
By binding this event consumer class to the party’s selection event, the business logic for populating the
related party’s data will be executed automatically on selection of a party by the user.
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The original event consumer class bound to this event contains the business logic for populating the accounts
data. Since your event consumer class would be over-riding the original binding, you will need to incorporate
the original business logic for populating the accounts data in your event consumer class.

Figure 6–15 Create Event Consumer Class

Step 4 Create Managed Bean
Youwill need to register the binding bean class as amanaged bean. Open the project's adfc-config.xml which
is present in theWEB-INF folder. In theManaged Beans tab, add the binding bean class as amanaged bean
with request scope as follows:

Figure 6–16 Creating Managed Bean

Step 5 Create Data Control
For the event consumer class's method to be exposed as an event handler, you will need to create a data
control for this class.
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1. In theApplication Navigator, right-click the event consumer Java file and create data control.

2. On creation of data control, an XML file is generated for the class and aDataControls.dcx file is
generated containing the information about the data controls present in the project. You will be able to
see the event consumer data control in theData Controls tab.

Figure 6–17 Create Data Control

3. Restart JDeveloper in theCustomization Developer Role to edit the customizations.

4. Ensure that the appropriateCustomization Context is selected.

Step 6 Add View Object Binding to Page Definition
Youwill need to add the view object binding to the page definition of the screen. To open the page definition of
the screen, follow these steps:

1. In the Application Navigator, open the Navigator Display Options for Projects tab and check the Show
Libraries option.

2. In the navigator tree, locate the JAR that contains the screen (com.ofss.fc.ui.view.party.jar).

3. Inside this JAR, locate and open the page definition XML
(com.ofss.fc.ui.view.party.partySearch.pageDefn.PartySearchMaintenancePageDef.xml)

4. After opening the page definition XML, add a tree binding for the view object
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(RelatedPartiesAndDetailsTableVO1) as follows:

Figure 6–18 Adding View Object Binding to Page Definition - Add Tree Binding
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Figure 6–19 Adding View Object Binding to Page Definition - Update Root Data Source

5. In Root Data Source, locate the view object which is present in thePartyAppModuleDataControl.
Select the required display attributes and click OK.

Step 7 Add Method Action Binding to the Page Definition
Youwill need to add themethod action binding for the event consumer data control to the page definition of the
screen.
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1. After opening the page definition XML, add themethod action binding for the
DemoPartySearchConsumer data control to the page definition as follows:

Figure 6–20 Page Data Binding Definition - Insert Item

2. Browse and locate the data control and click OK.
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Figure 6–21 Page Data Binding Definition - Create Action Binding

Step 8 Edit Event Map
Youwill need tomap theEvent Producer for the party selection event to theEvent Consumer defined by you
in the page definition.

1. In theApplication Navigator, select the page definition XML file.

2. In theStructure panel of JDeveloper, right-click the page definition XML and select Edit Event Map.
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Figure 6–22 Edit Event Map

3. In theEvent Map Editor panel, edit themapping for the required event.

4. Select the newly added Event Consumer's method.
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Figure 6–23 Event Map Editor

Step 9 Add UI Components to Screen
After making the required changes to page definition of the screen, you will need to add the UI components to
the screen JSFF. After opening the JSFF for the screen
(com.ofss.fc.ui.view.party.partySearch.PartySearchMaintenance.jsff), follow these steps:

1. Drag and drop thePanel Box, Panel Collection and Table components onto the screen.

2. Set the required columns for the Table component.

3. Drag and drop theOutput Text orCheck Box components as required inside the columns.

4. For each component, set the required attributes using theProperty Inspector panel of JDeveloper.

5. Add the binding for required components to the binding beanmembers.

6. Add the view object binding to the Table component.

7. Save changes made to the JSFF.
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Figure 6–24 Add UI Components to Screen

After saving all these changes, you will notice that JDeveloper has created a customization XML for each of
the customized entities in theADF Library Customizations Sources folder packaged as per the corresponding
base document's package and customization context (Customization Layer Name & Customization Layer
Value). These XML's store the difference between the base and customized entity. In our customization, you
can see the following generated XML's:

n PartySearchMaintenancePageDef.xml for the page definition customizations.

n DataBindings.cpx.xml for the data binding (view object binding) customizations.

n PartySearchMaintenance.jsff.xml for the UI customization to the screen JSFF.
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Figure 6–25 Application Navigator

Step 10 Deploy Customization Project
After finishing the customization changes, exit theCustomization Developer Role and start JDeveloper in
Default Role. Deploy the customization project as an ADF Library JAR (com.ofss.fc.demo.ui.view.party.jar).

1. Go to theProject Properties of themain application project and in the Libraries andClasspath, add
the following JARS:

n Customization Project JAR (com.ofss.fc.demo.ui.view.party.jar)

n Customization Class JAR (com.ofss.fc.demo.ui.OptionCC.jar)

n All dependency libraries and JARS for the project.

2. Start the application and navigate to theAdvanced Search screen.

3. Search for a party ID and select a party from theParty Search Results table.

4. On selection of a party, theRelation Details panel containing the related party’s data is displayed.
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Figure 6–26 Party Search

6.7.2 Approvals Framework
It is recommended to use ADF screen extensions for UI changes instead of mds in this scenario as it is easier
to upgrade to new version of product however themds approach is described below.

This third example of customization explains adding a Date Component to an existing screen to capture date
input from the input. This input is saved in the database.

Use Case Description: The Party →Contact Information→Contact Point screen is used to store the
various contact point details for a party. In the Contact Point Details tab, the user can select a Contact Point
Type and a Contact Preference Type and provide details for the same. User will be adding a field Expiry Date
as a date component to this tab. User will be adding a table to the database to save the user input for this field
and services for this screen will be added or modified.
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Figure 6–27 Contact Point Screen

To create the customization as mentioned in this use case, follow these steps:

Step 1 Host Application Changes
Since in this use case you need to save the input data in the database of the application, you need to do
certain modifications on the host application before creating the customizations on the client application.
Following are the changes that need to be done to the host application.

Step 2 Create Table in Application Database
To save the input data for the Expiry Date field, create a table in the application database. The table will also
need to have the Key columns for this field and the columns needed to store information about the record.
Create appropriate primary and foreign keys for the table as well.
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Figure 6–28 Create Table

After creating the table, you need to create the domain object and service layers. To create these entities,
follow these steps.

Step 3 Create Java Project
To contain the domain object and service layer classes, create a Java Project in eclipse. Give a title to the
project (com.ofss.fc.demo.party.contactexpiry) and add the required projects to the classpath of the project.

Figure 6–29 Create Java Project

Step 4 Create Domain Objects
You need to create the domain objects for the newly added table. As per the structure and package
conventions of OBP, create the domain objects as follows:
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1. Create class (com.ofss.fc.demo.domain.party.entity.contact.ContactExpiryKey) for the key columns
of the table. This class must extend the com.ofss.fc.framework.domain.AbstractDomainObject
abstract class. Add the properties, getters and setters for the key columns of the table in this class.
Implement the abstract methods of the superclass.

Figure 6–30 Create Domain Objects

2. Create interface (com.ofss.fc.demo.domain.party.entity.contact.IContactExpiry) for the domain object
class with getters and setters abstract methods for the Key domain object and the field Expiry Date.
This interfacemust extend the interface com.ofss.fc.framework.domain.AbstractDomainObject.

Figure 6–31 Create Interface

3. Create class (com.ofss.fc.demo.domain.party.entity.contact.ContactExpiry) for the domain object.
This class must implement the previously created interface and extend
com.ofss.fc.framework.domain.AbstractDomainObject abstract class. Add the properties, getters and
setters for Key object and Expiry Date field. Implement the abstract methods of the superclass.
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Figure 6–32 Create Class

After creating the domain objects, build the project. You need to use the Flex cube development
eclipse plug-in to generate the service layers.

Step 5 Set OBP Plugin Preferences
Before using the plug-in for generating service layer classes, you will need to set the required preferences for
the plug-in. In eclipse, go toWindows →Preferences →OBP Development and the set the preferences as
follows.

Figure 6–33 Set OBP Plugin Preferences

6 ADF Screen Customizations Using MDS | 109



6.7 Customization Layer Use Cases

Figure 6–34 Set OBP Plugin Preferences

Figure 6–35 Set OBP Pugin Prefernces
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Step 6 Create Application Service
You need to generate the application service layer classes using the OBP development plugin. Follow these
steps:

1. Open the domain object class (ContactExpiry).

2. On the getter method of the Key object, add a javadoc comment @PK.

3. Right click on the editor window and from context menu that opens, chooseOBP Development →
Generate Application Service.

4. In the dialog that opens, select the Java project for generated classes. You can use the project
previously created by you.

Figure 6–36 Create Application Service

5. Click onGenerate. Application Service classes is generated in the project.

The Java sourcemight contain some compilation errors due to syntax. Fix these errors and build the
project. The following classes should have been generated in the project.
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Figure 6–37 Application Service Classes Generated

Step 7 Generate Service and Facade Layer Sources
Before generating the service and facade layer sources, you need tomodify the Data Transfer Object (DTO).
When a service call is made from the client application for a transaction related to Contact Point, the Contact
Expiry transaction for the newly added Expiry Date field should be done in addition to the Contact Point
transaction. Hence, the DTO for this transaction should also contain the DTO for the Contact Point
transaction.

Tomodify the Data Transfer Object:

1. Open the ContactExpiryDTO class.

2. Delete themember ContactExpiryKey member and add ContactPoint member.

3. Re-factor references of the deletedmember with the addedmember.
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Figure 6–38 Modify Data Transfer Object (DTO)

To generate the service and facade layer sources:

1. Open the application service class (ContactExpiryApplicationService).

2. Right click on the editor window and from the context menu that opens, chooseOBP Development →
Generate Service and Facade Layer Sources.

3. In the dialog box that opens, select the Java project for the generated classes. You can use the project
previously created by you. Un-check the Overwrite Existing Files option.
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Figure 6–39 Generate Service and Facade Layer Sources

4. Click Finish.

Service and facade layer sources is generated in the project.

5. Certain classes might be generated twice. Delete the newly created copy of the classes and keep the
original.

6. Certain compilation errors might be present in the generated classes due to erroneous syntax. Fix
these compilation errors.

7. You will need to include a corresponding call to the Contact Point Application Service in the add,
update and fetch transactions of the Contact Expiry Application Service.

8. Open ContactExpiryApplicationServiceSpi andmodify the code as shown below.
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Figure 6–40 Modify ContactExpiryApplicationServiceSpi.java
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Figure 6–41 Modify ContactExpiryApplicationServiceSpi.java
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Figure 6–42 Modify ContactExpiryApplicationServiceSpi.java

9. The project should contain the Java packages as shown below:

Figure 6–43 Java Packages

Step 8 Export Project as a JAR
You need to export the Java project containing the domain object, application service and facade layer source
as a JAR.
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To export java project as JAR:

1. Right click on the project and choose Export.

2. Choose JAR File in the export options.

3. Provide an export path and name (com.ofss.fc.demo.party.contactexpiry.jar) for the JAR file.

4. Click Finish.

Figure 6–44 Export Java Project as JAR

Step 9 Create Hibernate Mapping
You need to create a hibernatemapping tomap the database table to the domain object.

Follow these steps:

1. Create ContactExpiry.hbm.xml file in the orm/hibernate/hbm folder of the config project of the host
application.

2. Add the entry for this XML in the orm/hibernate/cfg/party-mapping.cfg.xml hibernate configuration
XML.

3. Add themapping in ContactExpiry.hbm.xml as shown below.
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Figure 6–45 Create ContactExpiry.hbm.xml

Step 10 Configure Host Application Project
You need to configure the Contact Expiry Application Service and Facade Layer in the host application.

To configure, follow these steps:

1. Configure APPX layer as the service layer for Contact Expiry service.

2. Open properties/hostapplicationlayer.properties present in the configuration project and add an entry as
shown below.

Figure 6–46 Configure hostapplicationlayer.properties

3. Configure APPX layer proxy as the proxy for Contact Expiry service.

4. Open properties/ProxyFacadeConfig.properties present in the configuration project and add an entry as
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shown below.

Figure 6–47 Configure ProxyFacadeConfig.properties

5. Configure the JSON and Facade layer mapping for Contact Expiry service.

6. Open properties/JSONServiceMap.properties present in the configuration project and add the two
entries as shown below.

Figure 6–48 Configure JSONServiceMap.properties

Step 11 Deploy Project
After performing all the abovementioned changes, deploy the project as follows:

1. Add this project (com.ofss.fc.demo.party.contactexpiry) to the classpath of the branch application
project.

2. Open the launch configuration of the Tomcat Server. Add this project to the classpath of the server as
well.

3. Deploy the branch application project on the server and start it.

4. Client Application Changes.

After creating database table to hold the input data and after creating the related domain objects and service
and facade layers, you can customize the user interface. The customizations to the application have to be
done on the client application. To customize the UI, follow these steps.

Step 12 Create Model Project
You need to create amodel project to hold the required view objects and applicationmodule.

To create themodel project, follow these steps:
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1. In the client application, create a new project of the type ADFModel Project.

Figure 6–49 Create Model Project

2. Give the project a title (com.ofss.fc.demo.ui.model.party) and set the default package as the same.
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Figure 6–50 Create Model Project - Configure Java Settings

3. Click on Finish to create the project.

Step 13 Create Application Module
You need to create an applicationmodule to contain the information of all the view objects that you need to
create. To create an applicationmodule, follow these steps:

1. Right click on themodel project and select New.

2. Choose ApplicationModule from the dialog box that opens.
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Figure 6–51 Create Application Module

3. Set the package of the applicationmodule to the default package (com.ofss.fc.demo.ui.model.party).

4. Provide a name to the applicationmodule (DemoPartyAppModule).
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Figure 6–52 Set Package and Name of Application Module

5. Click on Next and let the rest of the options be set to the default options.

6. You will see a summary screen for the applicationmodule. Click on Finish to create the application
module.
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Figure 6–53 Summary of Application Module Created

Step 14 Create View Object
You need to create a view object for the newly added Expiry Date field. This view object is used on the screen
to display the value of the field as well as to take the input for the field.

To create the view object, follow these steps:

1. Right click on the Java package com.ofss.fc.demo.ui.model.party and select New View Object.

2. In the dialog box that opens, provide a name (ContactExpiryVO) for the view object.

3. Provide a package (com.ofss.fc.demo.ui.model.party.contactexpiry) for the view object.

4. For the Data Source Type option, select Rows populated programmatically, not based on a query.

5. Click on Next.

6. In the Attributes dialog, create a new attribute for Expiry Date field.

7. Provide a name (ExpiryDate) and type (Date) for the attribute.

8. For the Updatable option, select Always.
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Figure 6–54 Create View Object
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Figure 6–55 View Attribute

9. Click Next. On the ApplicationModule dialog, browse for the previously created
DemoPartyAppModule.
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Figure 6–56 Application Module

10. For all other dialogs, keep the default options.

11. Click Next till you reach the summary screen as shown below.

12. Click on Finish to create the view object.
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Figure 6–57 Create View Object - Summary

Step 15 Create View Controller Project
You need to create a view controller project to contain the UI elements. This project will also hold the
customizations to the application.

To create the view controller project, follow these steps:

1. In the client application, create new project of the type ADF View Controller Project.

2. Give the project a title (com.ofss.fc.demo.ui.view.party) and set the defaults package to the same.
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Figure 6–58 Create View Controller Project

3. Click on Finish to finish creating the project.
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Figure 6–59 Name your Project

4. Right click on the project and go to Project Properties. In the Libraries and Classpath tab, add the
following:

5. The Jar containing the screen to be customized (com.ofss.fc.ui.view.party.jar).

6. The Jar containing the domain objects and services for Contact Expiry
(com.ofss.fc.demo.party.contactexpiry.jar) as created in host application project.

7. All the required dependent Jars for the above Jars.

8. The Jar containing the customization class (com.ofss.fc.demo.ui.OptionCC.jar).

9. In the Dependencies tab, browse for and add the previously created adf model project
(com.ofss.fc.demo.ui.model.party).

10. In the ADF View tab, check the Enable Seeded Customizations option to enable this project for
customizations.
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Figure 6–60 Libraries and Classpath

Figure 6–61 Dependencies

11. Save the changes by clicking OK and rebuild the project.

Step 16 Create Maintenance State Action Interface
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Create an interface containing themethod definition for amaintenance action. This interface is implemented
by the requiredmaintenance state actions classes for the screen to be customized. The state actionmethod
will take the instance of the backing bean as a parameter.

Figure 6–62 Create Maintenance State Action Interface

Step 17 Create State Action Class
You need to create a class which will contain the business logic for the create transaction for this screen. This
class should have following features:

n Implements the previously created state action interface.

n Creates the Contact Point DTO from the users input.

n Creates an instance of the Contact Point service proxy.

n Calls the addmethod of the service passing the DTO.

Step 18 Create Update State Action Class
Youwill need to create a class which will contain the business logic for the update transaction for this screen.
This class should have following features:

n Implements the previously created state action interface.

n Creates the Contact Point DTO from the users input.

n Creates an instance of the Contact Point service proxy.

n Calls the updatemethod of the service passing the DTO.
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Figure 6–63 Create Update State Action Class
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Figure 6–64 Create Update State Action Class

Step 19 Create Backing Bean
You need to create a backing bean class for the screen to be customized. This class should have the
following features:

n Should implement the interface ICoreMaintenance.

n Privatemembers for the to be added UI Components in customization and public accessors for the
same.

n Privatemember for the backing bean of the original backing bean of the screen (ContactPoint) which is
initialized in the constructor of this class.

n Privatemember for the parent UI Component of the newly added UI components and public accessors
which returns the corresponding component of the backing bean.

n Privatemember for the newly added view object (ContactExpiryVO) and the current view objects
present on the screen.
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Figure 6–65 DemoContactPoint.java displays the View Objects

n clear() method which handles the user action Clear.

n save() method which handles themaintenance state actions Create and Update.

n Depending on the current state action, the save() method should instantiate either
DemoCreateContactPoint or DemoUpdateContactPoint and perform the corresponding state action
methods.
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Figure 6–66 DemoCreateContactPoint / DemoUpdateContactPoint

n A public method to create the Contact Expiry DTO from the user's input on the screen.

Figure 6–67 Create Contact Expiry DTO

n A value change event handler for the Expiry Date UI Component.
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Figure 6–68 Value Change Event Handler for the Expiry Date UI Component

n Value change event handlers for the existing UI Components on change of which the screen data is to
be fetched.
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Figure 6–69 Value Change Event Handlers for Existing UI Components

n Method containing the business logic to fetch screen data using Contact Expiry proxy service.
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Figure 6–70 Method to fetch Screen Data using Contact Expiry Proxy Service

Step 20 Create Managed Bean
You need to register the DemoContactPoint backing bean as amanaged bean with a backing bean scope.

1. Open the project's adfc-config.xml which is present in theWEB-INF folder.

2. In theManaged Beans tab, add the binding bean class as amanaged bean with backing bean scope as
follows:
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Figure 6–71 Create Managed Bean

Step 21 Create Event Consumer Class
You need to create an event consumer class to consume the Party Id Change event. When the user inputs a
party id on the screen, the business logic in this event consumer class will be executed automatically.

Figure 6–72 Create Event Customer Class

Step 22 Create Data Control
For the event consumer class's method to be exposed as an event handler, you need to create a data control
for this class.

1. In the Application Navigator, right click on the event consumer Java file and create data control.

On creation of data control, an XML file is generated for the class and a DataControls.dcx file is
generated containing the information about the data controls present in the project. You will be able to
see the event consumer data control in the Data Controls tab.
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Figure 6–73 Create Data Control

2. You should now restart JDeveloper in the Customization Developer Role to edit the customizations.
Ensure that the appropriate Customization Context is selected.

Step 23 Add UI Components to Screen
Browse and locate the JSFF for the screen to be customized
(com.ofss.fc.ui.view.party.contactPoint.contactPoint.jsff) inside the JAR (com.ofss.fc.ui.view.party.jar).
Open the JSFF and do the required changes as follows:

1. Drag and drop the Panel Label & Message and Date UI components at the required position on the
screen.

2. For each component, set the required attributes using the Property Inspector panel of JDeveloper.

3. Modify the containing Panel's width and number of columns attributes as required.

4. For each component, add the binding to the DemoContactPoint backing bean's corresponding
members.

5. Add the value change event binding for the Expiry Date UI component to the backing bean's
correspondingmethod.

6. Change the value change event binding for the existing UI component on change of which the screen
data is fetched.

7. Change the backing bean attribute of the screen to the previously created DemoContactPoint backing
bean.

8. Save the changes. You will notice that JDeveloper has created a customization XML in the ADF
Library Customizations folder to save the differences between the base JSFF and the customized
JSFF. The generated contactPoint.jsff.xml should look similar to as shown below.
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Figure 6–74 Generated contactPoint.jsff.xml

Step 24 Add View Object Binding to Page Definition
You need to add the view object binding for the previously created ContactExpiryVO view object to the page
definition of the screen to be customized.

1. Browse and locate the page definition for the screen to be customized
(com.ofss.fc.ui.view.party.contactPoint.pageDef.ContactPointPageDef.xml) and open it.

2. Add an attributeValues binding as shown below.

Figure 6–75 Add an attributeValues binding

3. For Data Source option, locate the previously created ContactExpiryVO view object present in the
DemoPartyAppModule.

4. For Attribute option, choose the ExpiryDate attribute present in the view object.
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Figure 6–76 Create Attribute Binding

Step 25 Add Method Action Binding to Page Definition
You need to add themethod action binding for the previously created DemoPartyIdEventChangeConsumer
event consumer class to the page definition of the screen to be customized.

1. Add amethodAction binding as shown below.

Figure 6–77 Add a methodAction binding

2. For the Data Collection option, locate the previously created DemoPartyIdChangeEventConsumer
data control.
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Figure 6–78 Create Action Binding

Step 26 Edit Event Map of Page Definition
You need tomap the Event Producer for the party id change event to the previously created Event Consumer.

1. In the Structure panel of JDeveloper, right click on the page definition and select Edit Event Map.

2. In the Event Map Editor dialog that opens, edit themapping for the party id change event. Select the
previously created Event Consumer's method.
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Figure 6–79 Select the Event Consumer Method

3. Save the changes. You will notice that JDeveloper has created a customization XML in the ADF
Library Customizations folder to save the differences between the base JSFF and the customized
JSFF. The generated contactPoint.jsff.xml should look similar to as shown below.

Figure 6–80 Generated contactPoint.jsff.xml

Step 27 Deploy Customization Project
After finishing the customization changes, exit the Customization Developer Role and start JDeveloper in
Default Role. Deploy the view controller project as an ADF Library Jar (com.ofss.fc.demo.ui.view.party.jar).

Go to Project Properties of themain application project and in the Libraries and Classpath, add the following:
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1. View controller project Jar (com.ofss.fc.demo.ui.view.party.jar)

2. Host domain Jar (com.ofss.fc.demo.party.contactexpiry.jar)

3. Customization Class Jar (com.ofss.fc.demo.ui.OptionCC.jar)

4. All dependency libraries and Jars for the project.

5. Start the application and navigate to Party →Contact Information→Contact Point screen. Input a
party id on the screen and perform the read, create and update actions on Contact Point. You need to
input data and fetch value for the newly added Expiry Date field.

Figure 6–81 PI041 - Contact Point Screen

6.7.3 Override the product managedBean
Screen customizations could be used to handle a product code which does not serve the necessary
functionality and needs to be re-written.
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7 ADF Taskflow Generation for
Customization or Localization

7.1 Introduction
OBP product uses Oracle FUSION technology. The Presentation layer is built using Oracle ADF (Application
Development Framework). It is recommended that the Presentation layer should not have any business logic;
business policy checks should be in the host application service. Business rules in presentation should be
limited tomaking UI components visible or read-only etc to make the UI convenient to use.

In an effort to improve productivity, maintainability, and extendibility, the ADF Taskflow Generator has been
developed.

The key features of the ADF Taskflow Generator are:

n Complies to new Integrable Taskflow framework.

l CommonHelper for taskflows “IntegrableTaskFlowHelper.java”. It acts as amediator to
facilitate encapsulation.

l Widget specific Handler class to handle helper and backing bean events.

l Widget specific “TaskFlowContext” for specifying parameters or behaviors expected by
embedded taskflow.

l Widget specific “DataObject” for passing DTO’s to embedded taskflow.

l Widget specific “Event Producer” facilitating standard events.

l Extensions for localization or customization.

n TheWidget code can be re-generated without any impact to themanually written code.

n Input of Widget Configurations via Xtext editor.

7.2 Installing the Generator
Installation Steps

1. Install eclipse on your machine and add the following jars in the plugins folder:

n com.ofss.fc.ui.generator.widgetmodel.jar

n com.ofss.fc.ui.generator.widgetmodel.ui.jar

2. Configure “OBP UI Plugin -> Configuration” in Preferences. Refer below screenshot. The combination
of the “Workspace Location” in Configuration and “projectLocation” in the .wconf is where the plug-in
expects to generate the code. The “Config Location” is where the plug-in expects to generate the Java
Property files.
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Figure 7–1 Preferences screen

7.3 Using the Generator
Instructions on how to Create Widget Configuration

1. Start eclipse and create new file with extension .wconf usingmenu File --> New --> File.

2. Input widget configuration. Refer to the sample wconf for consulting.

3. Use shortcut key CTRL+SPACE to be prompted for valid grammar. The .wconf grammer syntax
check is rudimentary (e.g. valueChangeHandlerRequired though not applicable for a component type
“OutputText” will not show as error until you build the project, in such cases fix the .wconf to remove
the valueChangeHandlerRequired attribute or manual remove the generated attribute).

Instructions on how to Generate Widget Code

1. Open the .wconf file in eclipse.

2. Right click on the editor (.wconf file) and select GenerateWidgets. The widgets for the particular
widget configuration will be generated.

3. Error logs can be checked at C:\Users\<your id>\UI_Plugin_Logs.
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4. Certain manual step are required to complete the taskflow creation.

5. Refresh themodel until the xml files for the two VO’s are visible. Close and reopen the project if
necessary.

6. RowImpl for the VO’s needs to be generated using following steps:

a. Open the corresponding VO file in ADF.

b. Go to Overview.

c. Click on Edit java Option.

d. Select checkbox Generate view object class.

e. Select checkbox Include bind variable accessors.

f. Select checkbox Include custom java data sourcemethods.

g. Select checkbox Generate view Row Class.

h. Select the subset Select InClass Accessors.

i. Click onOk.

7. For the generation of corresponding vo entry in *.jpx.

a. The project once opened in ADF, themodel needs to be refreshed two to three times. ADF
generates the entries automatically.

8. If the taskflow has a Event Consumer execute following to generate the corresponding Data control:

a. Right click on *EventConsumer.java.

b. Select Create Data Control.

c. If the taskflow has a Event Producer, execute the following to generate the corresponding Data
control.

d. Right click on *EventProducer.java.

e. Select Create Data Control.

9. Rebuild the project after the above changes aremade tomake sure that all the changes are effectively
reflected.

Steps to Integrate the Generated Code

1. Code is generated directly in Target Package. Re-build & re-deploy the taskflows jar.

2. If the taskflow is a simple embeddable taskflow, include new Taskflow as region on existing screen.

3. If the taskflow uses theMaintenance/ Transaction template and has to be added as a screen, add the
new TaskCode entries in following files:

n menu_elements_en.csv"

n taskflowDefn_element.csv

n *-taskflow-definition located in com.ofss.fc.view.* (only for taskflow as a screen)

Manual Coding

1. Adding UI components manually.

2. Add component to JSFF, corresponding backing event method and delegate call to taskflow handler.
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3. A JAPA utility will generate the required consulting hooks (Entries in Abstract Handler and EXT files).

4. Component’s entries for VO, State VO and Resource bundle will need to be donemanually.

5. Manual code should be added to Handler, Utils and Assembler methods.

6. Host calls will be generated in Utils class, wiring to specific event to be donemanually.

7. UI specific business rules like enabling/disabling UI components can be added to a Business Rules
class (Invoked via Handler).

8. If VO’s or any collection objects aremanually created, ensure they are added to the viewobjectMap or
the collectionVOMap. If not they need to be clearedmanually in the destroyView method in handler.

9. Add code to renderView method in handler to utilize the Taskflow Context / Data Object set.

10. Add additional assembler code as per requirement.

11. Add attributes to taskflow context object as per requirement.

12. DONOTmakemanual changes in abstract classes / ext classes.

Extensions for Localization/Customization

n Extensions for localization/customization will be generated in package <ext>.

n Extensions are in similar lines to extensions in the OBP Application Service.

Mandatory Steps for Localization/Customization specific wconf files

Refer cz.wconf and lz.wconf

1. Create new/empty files like AppModule, DataBindings and DataControls if not already present before
generating using the generator

2. Specify the client name (Example : nab) for cz specific taskflows.

3. Specify the locale name (au or us) for lz specific taskflows.

Cz.wconf sample
project "com.ofss.fc.cz.nab.ui.taskflows.ins" {
projectLocation "/TaskFlows/"
rbConfigLocation "/resources/cz/nab/ins/"
packageName "com.ofss.fc.cz.nab.ui.taskflows.ins"
clientName "nab"
}
widget "CCIPanelTest" {
widgetType ADF
appModule "NABINSTaskflowAppModule"
description "This is the Access CCI Panel TaskFlow since R2.4"
isConsumer false
isProducer false
fullyQualifiedTaskFlowDTO java.lang.Object
RemoteProcedureCall {
methodName "fetchEligibilityPremiumDetails"
rpcDetails {
fullyQualifiedHostDTO
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com.ofss.fc.cz.nab.app.ins.cci.dto.ConsumerCreditInsuranceDetailsD
TO
endPointProxy CCIApplicationServiceProxy
fullyQualifiedAPI
com.ofss.fc.cz.nab.app.ins.service.cci.service.client.proxy.ICCIAp
plicationServiceProxy.fetchEligibilityPremiumDetails
(SessionContext,LendingProductGroupLinkageDTO,ApplicantDataDTO
[],ProductDetailsDTO,ConsumerCreditInsuranceDetailsDTO)
responseClass com.ofss.fc.cz.nab.app.ins.cci.dto.CCIResponse
}
}
component accessPanelGroup
{
componentType PanelGroupLayout
isBindingRequired false
attributesForPanelGroupLayout {
layout Horizontal
}
children
{
component applicantDetails {
componentType OutputText
isBindingRequired true
label "Applicant Details"
accessibilityText "Applicant Data Grid Start"
}
component applicantDataGrid{
componentType InputTableWithLabel
isBindingRequired true
attributesForTable
{
tableSummary "Applicant Details"
width "100"
immediate true
filterVisible false
columnDetails
{name "colSelAppl" fullyQualifiedName "String"
columnType SELECTONECHOICE headerText "SelectApplicant"}
{name "colApplName" fullyQualifiedName "String"
columnType OUTPUTTEXT headerText "ApplicantName"}
{name "colApplAge" fullyQualifiedName "String"
columnType OUTPUTTEXT headerText "ApplicantAge"}
{name "colApplPrem" fullyQualifiedName "String"
columnType OUTPUTTEXT headerText "ApplicantAnnualPremium"}
}
isVisible true
isRendered true
isEditable false
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accessibilityText "Applicant Details"
}
component applicantDetailSpacer {
componentType Spacer
isBindingRequired false
attributesForSpacer {
width "5"
height "5"
}
}
component okButton {
componentType CustomButton
isBindingRequired true
label "Proceed With Protection"
accessibilityText "Proceed With Protection"
clickHandlerRequired true
}
component cancelButton {
componentType CustomButton
isBindingRequired true
label "Proceed With Protection"
accessibilityText "Proceed With Protection"
clickHandlerRequired true
}
}
}
end
}

Lz.wconf sample
project "com.ofss.fc.lz.us.ui.taskflows.party" {
projectLocation "/TaskFlows/"
rbConfigLocation "/resources/taskflows/party/"
packageName "com.ofss.fc.lz.us.ui.taskflows.party"
locale "us"
}
widget "PartySampleWidget" {
widgetType ADF
appModule "LzUsTaskFlowsPartyAppModule"
description "Party Service LZ specific Taskflow"
isConsumer false
isProducer false
fullyQualifiedTaskFlowDTO java.lang.Object
component accessPanelGroup
{
componentType PanelGroupLayout
isBindingRequired false
attributesForPanelGroupLayout {
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layout Horizontal
}
children
{
component applicantDetails {
componentType OutputText
isBindingRequired true
label "Applicant Details"
accessibilityText "Applicant Data Grid Start"
}
component applicantDataGrid{
componentType InputTableWithLabel
isBindingRequired true
attributesForTable
{
tableSummary "Applicant Details"
width "100"
immediate true
filterVisible false
columnDetails
{name "colSelAppl" fullyQualifiedName "String"
columnType SELECTONECHOICE headerText "SelectApplicant"}
{name "colApplName" fullyQualifiedName "String"
columnType OUTPUTTEXT headerText "ApplicantName"}
{name "colApplAge" fullyQualifiedName "String"
columnType OUTPUTTEXT headerText "ApplicantAge"}
{name "colApplPrem" fullyQualifiedName "String"
columnType OUTPUTTEXT headerText "ApplicantAnnualPremium"}
}
isVisible true
isRendered true
isEditable false
accessibilityText "Applicant Details"
}
component applicantDetailSpacer {
componentType Spacer
isBindingRequired false
attributesForSpacer {
width "5"
height "5"
}
}
component okButton {
componentType CustomButton
isBindingRequired true
label "Proceed With Protection"
accessibilityText "Proceed With Protection"
clickHandlerRequired true
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}
component cancelButton {
componentType CustomButton
isBindingRequired true
label "Proceed With Protection"
accessibilityText "Proceed With Protection"
clickHandlerRequired true
}
}
}
end
}

Do’s and Don’ts

Do’s

n When generating widget

n Widget configuration (.wconf file) should be checked into SVN.

n List all components required on screen in a single .wconf.

n Widget generation is a onetime activity. Include host calls and all required components in .wconf to
minimizemanual coding.

n Manual changes

n Refer Manual coding.

n Interfacing with Container/Consumer Taskflow.

n Modify the <widget>TaskFlowContext to include parameters / behaviors to be exposed to the
consumer taskflow by your integrable taskflow.

n Modify the DataObject to include DTO’s to be passed to your integrable taskflow by the consumer
taskflow.

Don’ts

n DONOTmake changes in any abstract class in generated code. “Warning : Changes done to this file
will be lost on re-generation” is mentioned in these files.

n DONOT introduce your own helper, use the common IntegrableTaskFlowHelper.

n DONOT use page flow scope attributes in Handler for UI Component Rendered / Visible / Disabled
attributes. Add attributes to State VO instead.

n Pleasemake sure that if you are changing taskflow DTO then you are changing it throughout the
taskflow and not in few files only.

n Pleasemake sure that Handler and assemblers extend their respective abstract classes.
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7.4 ADF TaskFlow Generation Usecases

7.4.1 Extensive UI components to be included on screen
If there is more than an adequate number of fields to be included on an already existing product screen its
adviceable to create a new taskflow for the same using the taskflow generater following the steps mentioned
above.

SampleWconfs is available here com.ofss.fc.taskflows.wconf. Once the the taskflow is generated include
the taskflow using the Extension hooks.
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8 Human Task Screen Extension

8.1 Introduction
Human task screen uses internally ADF taskflows except the primary worklist actions. Human screen
extensions work similar to ADF screen extensions, where the backing bean and controller classes of human
task have the provision for extension, similar to the UI extension as explained in Section 5.1 UI Extension
Interface, Section 5.2 Default UI Extension, Section 5.3 UI Extension Executor, and Section 5.4 Extension
Configuration. From the perspective of customization, the recommendation is to do customization on the
taskflows used internally. For CSS customization, see the below the details.

8.2 Custom CSS Skin
If ADF skin is already available and you just want to change the skin family reference in “trinidad-config.xml”,
directly apply the Section 8.2.2 Apply New Skin . If you want to create a new ADF skin andmerge with the
existing skin families to “trinidad-skins.xml”, start from Section 8.2.1 Create New ADF Skin .

8.2.1 Create New ADF Skin
To create a new ADF skin and package it as library to refer to new skin families files, perform the following
steps:

1. Create ADF skin project and skin families as given in https://docs.oracle.com/cd/E16162_
01/user.1112/e17456/adfsg_project.htm#ADFSG490:

Figure 8–1 Sample trinidad-skins.xml

2. Package the above project as given in https://docs.oracle.com/cd/E16162_
01/user.1112/e17456/adfsg_apply.htm#ADFSG404.

After deployment, the package structure should be as shown in the following screenshot:
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8.2 Custom CSS Skin

Figure 8–2 Package Structure

3. Deploy or add the deployed jar to obp ui library references.

4. Reference implementation can be provided on request.

8.2.2 Apply New Skin
n Option #1: The skin id can be configured with the help of property ‘default.humantask.skinfamily’ in

seed data available as part of FLX_FW_CONFIG_ALL_B.

Figure 8–3 Sample Data

n Option #2:Over and above the above the option 1, the extension can be implemented for
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“postCustomBranding” operation of CommonTaskFormPagePhaseListenerImpl [extension class:
com.ofss.fc.workflow.ui.common.ext.ICommonTaskFormPagePhaseListenerImplUIExt]

Figure 8–4 Sample Implementation
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9 Receipt Printing

OBP has many transaction screens in different modules where it is desired to print the receipt with different
details about the transaction. This functionality provides the print receipt button on the top right corner of the
screen which gets enabled on the completion of the transaction and can be used for printing of receipt of the
transaction details.

For example, if the customer is funding his term deposit account, the print receipt option will print the receipt
with the details like Payin Amount, Deposit Term etc at the end of the transaction. The steps to configure this
option in the OBP application are given in the following section.

9.1 Prerequisite
Following are the prerequisites for receipt printing.

9.1.1 Identify Node Element for Attributes in Print Receipt Template
The list of all the elements that are present in the particular task code screen and need to be displayed in the
printed receipt can be identified with the help of the VO object utility. This utility helps in identifying all the
node elements which are available on the screen and can be used in the print receipt template. This utility
VOObjectUtility can be used to generate the data required for the functionality to work.

Once the utility is imported in the workspace, the input.properties file needs to be updated with the location of
module's UI, location of task flow directory, location of config directory and the output directory where you
want the output of the utility.

Figure 9–1 Input Property Files

In the build path of the utility, three libraries (commons-io, xalan and xmlparserv2) need to be added as they
are required for execution of the utility.
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Figure 9–2 Build Path of Utility

Then themainmethod of the VOAttributesFinder.java class in the utility is executed.
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Figure 9–3 Utility Execution

On the execution of the utility, the Excel file is generated. The task codes can be filtered in the Excel file for
viewing different RTF node value of different attributes available on the particular screen.

Figure 9–4 Excel Generation

9.1.2 Receipt Format Template (.rtf)
This template is used for defining the format of the output receipt. Different data elements which need to be
shown in the output receipt arementioned in this RTF report format template. The node will be taken from the
above generated Excel file from 'RTF Node' column for specifying the output value in the final output RTF.

9 Receipt Printing | 165



9.2 Configuration

The sample rtf template is shown below:

Figure 9–5 Receipt Format Template

9.2 Configuration
This section describes the configuration details.

9.2.1 Parameter Configuration in the BROPConfig.properties
Following configuration parameters are required to be set in the BROPConfig.properties file.

n receipt.print.copy: Set to ‘S’ (default) if Single receipt is required. Else, set to ‘M’ for multiple receipts.
The receipt will be stored in current posting date ‘month/date’ folder structure.

n receipt.base.in.location: Location for the RTF templates, which is configured as
‘config\receipt\basein\template\’ structure on the UI server. (For RTF development purpose this
location will also have the XML generated while processing receipt.)

n receipt.base.out.location: Location for generated receipt, which is configured as
‘config\receipt\baseout\’ structure on the UI server.

n ui.service.url : UI URL http://IP:port format.
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9.2.2 Configuration in the ReceiptPrintReports.properties
This file contains the key value pair of the Task Code of the screen and the corresponding template names,
comma separated if more than 1 template is referred by screen.

TaskCode=RTF Filename

Where TaskCode: task code of screen for which receipt print will be enabled and RTF Filename: name of the
RTF template which will be used for the creation of the output with the same filename.

For example, TD002=FundTermDeposit

Figure 9–6 Receipt Print Reports

9.3 Implementation
The implementation for the print receipt functionality is explained in the following steps:

1. Once the screen is opened, Template checks ‘ReceiptPrintReports.properties‘ file if the Task code of
the opened screen is present in the property file. The ‘Receipt Print’ button will be rendered in a
disabled state.

2. On successful completion of transaction (successful Ok click), Receipt Print button gets enabled.

3. On click of Receipt Print button, all the VO’s on current screen are fetched and created as a XMLwith
data (for RTF development reference, this XML is not deleted at themoment but on environments
these will be deleted). The RTF and XMLmerge up to create and open the receipt in the pdf format.

4. Receipt will be stored with the file name as <Logged in userId_TemplateName>

The sample output receipt in the PDF form is shown below:
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Figure 9–7 Sample of Print Receipt

9.3.1 Default Nodes
As per the functional specification requirement, some default nodes are already added in the generated XML.
The list of those nodes are as follows:

n BankCode

n BankShortName

n BranchName

n PostingDate

n UserName

n BankAddress

n BranchAddress

n LocalDateTimeText

9.4 Special Scenarios
There are some cases, where some of the attributes are not available in the VOs of the screen and the value
needs to be picked from the response of the transaction. There are also some data values which need to be
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formatted first and then published in the PDF.

These values can be added to the pageFlowScopeMap variable 'receiptPrintOtherDetailsMap'.

The population of those values needs to be done in the Backing Bean, after getting the response of the
transaction in the followingmanner:

MessageHandler.addMessage(payinResponse.getStatus());
receiptDetails.put("TransactionRefNo",payinResponse.getStatus
().getInternalReferenceNumber());
SimpleDateFormat receiptTimeFormat = new SimpleDateFormat("hh:mm:ss
a");
SimpleDateFormat receiptDateFormat = new SimpleDateFormat("dd-MMM-
yyyy");
HashMap<String,String> receiptDetails = new HashMap<String, String>
();
Date date=new Date(getSessionContext().getLocalDateTimeText());
receiptDetails.put("PostingTime", receiptTimeFormat.format
(date.getSQLTimestamp()));
if(payinResponse!=null && payinResponse.getValueDate()!=null) {
receiptDetails.put("ValueDate",receiptDateFormat.format
(payinResponse.getValueDate().getSqlDate()));
}
ELHandler.set("#{pageFlowScope.receiptPrintOtherDetailsMap}",
receiptDetails);

Internally, the functionality adds all the details in map variable, other than VO's data. While receipt printing,
template checks theMap variable and if not null, it gets all the key-value from themap and show them in XML
which is used later on for generation of receipt.
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10 Extensibility Usage – OBP Localization
Pack

OBP shall be releasing localization pack which ensures an optimized implementation period by adapting the
product to different regions by implementing common region specific features pre-built and shipped. Every
bank in different regions have different tax laws, different financial policies and so on. The policies in US will
be different from those in Australia.

The localization packs leverageOBP extensibility to incorporate regional features and requirements by
implementing different extension hooks for host and / or different JDeveloper customization functionalities for
UI layer. This section presents a use case from OBP localization pack as implemented using the extensibility
guidelines as a sample which can be referred to and followed as a guideline. Customization developers can
implement bank's specific requirements on similar lines.

For example, in LCM022 'Perfection Capture' screen, the details section is shownwith the additional fields
which are defined for a particular location.

Figure 10–1 Perfection Capture Screen
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10.1 Localization Implementation Architectural Change
Architecturally, the following points are considered:

n Localization package will be over and above the product.

n Customization packages will be over the Localization and the Product.

n Any changes done for Localization should ensure that future product changes as well as customization
changes will work seamlessly without any impact.

The additional fields which get identified and developed as part of localization requirements are in its own
project, package, configuration, constant files and tables.

For example, the typical flow of the abovementioned perfection attributes added as part of localization
requirement is shown below:

Figure 10–2 Localization Implementation Architectural Change

The Package structure for the implementation is shown below:
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Figure 10–3 Package Structure

10.2 Customizing UI Layer
This section explains the customization of UI layer.

10.2.1 JDeveloper and Project Customization
For the customization of the UI layer, JDeveloper needs to be configured in the customizable mode as
explained in the ADF Screen Customization Sections.

The example for the customization of the JDeveloper is described below:

CustomizationLayerValues.xml
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Figure 10–4 Customization of the JDeveloper

Figure 10–5 Customization of the JDeveloper

adf-config.xml

If the changes are not reflecting, adf-config.xml needs to be opened from the application resources and
Configure Design TimeCustomization layer values highlighted in the below image needs to be clicked. It will
create a CustomizationLayerValues.xml insideMDS DT folder in application resources. All the content from
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<JDEVELOPER_HOME>/jdeveloper/jdev/CustomizationLayerValues.xml needs to be copied to this
CustomizationLayerValues.xml. This is to ensure that the changes are reflected at the application level.

Figure 10–6 Configure Design Time Customization layer
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Figure 10–7 Enabling Seeded Customization

Libraries and Classpath

In the "Libraries and Classpath" section, the previously deployed com.ofss.fc.lz.au.ui.OptionCC.jar
containing the customization class then needs to be added.
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Figure 10–8 Library and Class Path

adf-config.xml

In theApplication Resources tab, the adf-config.xml present in theDescriptors/ADFMETA-INF folder needs
to be opened. In the list of Customization Classes, all the entries should not be removed and the
com.ofss.fc.lz.au.ui.OptionCC.OptionCC class to this list needs to be added.
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Figure 10–9 MDS Configuration

Jdeveloper is then restarted and the entry needs to be checked for com.ofss.fc.lz.au.ui.OptionCC. If the jar
entry is not reflecting, then source needs to be clicked and the entry as highlighted and shown in the below
image needs to bemanually added.
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Figure 10–10 MDS Configuration

10.2.2 Generic Project Creation
After creating the Customization Layer, Customization Class and enabling the application for Seeded
Customizations, the next step is to create a project which will hold the customizations for the application.
Generic project is then created with the following technologies:

n ADF Business Components

n Java

n JSF

n JSP and Servlets

Following jars must then be added to the Project Properties and in the classpath:

n Customization class JAR (com.ofss.fc.lz.au.ui.OptionCC.jar)

n The project JAR which contains the screen / component to be customized. For example, if you want to
customize the Collateral Perfection Capture screen, the related project JAR is
com.ofss.fc.ui.view.lcm.jar.

n All the dependent JARS / libraries for the project needs to added.

n Finally newly created project (example: ’com.ofss.fc.lz.au.view.lcm’) needs to be enabled for Seeded
Customizations.

10.2.3 MAR Creation
After implementing customizations on objects from an ADF library, the customizationmetadata is stored by
default in a subdirectory of the project called libraryCustomizations. Although ADF library customizations at
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the project level is created andmerged together during packaging to be available at the application level at
runtime. Essentially, ADF libraries are JARs that are added at the project level, whichmap to library
customizations being created at the project level. However, although projects map to web applications at
runtime, theMAR (which contains the library customizations) is at the EAR level, so the library
customizations are seen from all web applications.

Therefore, an ADF library artifact are customized in only one place in an application for a given customization
context (customization layer and layer value). Customizing the same library content in different projects for
the same customization context would result in duplication in MAR packaging. To avoid duplicates that would
cause packaging to fail, customizations are implemented for a given library in only one project in your
application.

Step 1
Select the Application Properties.

Figure 10–11 MAR Creation

Step 2
Import com.ofss.fc.lz.au.ui.view.lcm project into application. Click ApplicationMenu and select Application
Properties.
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Figure 10–12 MAR Creation - Application Properties

Step 3
Select Deployment and click New.
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Figure 10–13 MAR Creation - Create Deployment Profile

Step 4
Select theMAR File option.
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Figure 10–14 MAR Creation - MAR File Selection

Step 5
Select MAR from Archive Type and give a name ending with MAR and click Ok.
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Figure 10–15 MAR Creation - Enter Details

Step 6
Select the ADF Library Customization for com.ofss.fc.lz.au.ui.view.lcm.
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Figure 10–16 MAR Creation - ADF Library Customization

Step 7
Select the project for which Library Customization will be included inMAR (com.ofss.fc.lz.au.ui.view.lcm)
and click OK.

Step 8
Select View (EAR File) and click Edit.
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Figure 10–17 MAR Creation - Edit File

Step 9
Select Application Assembly and check the createdMAR (lznMAR) and click ok on defaults.
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Figure 10–18 MAR Creation - Application Assembly

10.3 Source Maintenance and Build
This section describes the sourcemaintenance and build details.

10.3.1 Source Check-ins to SVN
Along with UI andmiddleware sourcemaintenance, there is a set of metadata files required to be packaged in
the deployable packages in order for customization. When performing any changes to a product screen in
"customizationmode" the corresponding <screen filename>.xml gets generated. In case of taskflows, the
metadata file is <page definition filename>.xml. The path structure is provided in the below table.

For
page
definit
ion

File
name
(with
path)

adfmsrc/com/ofss/fc/ui/view/lcm/collaterals/collateralPerfectionCapture/
pageDefn/CollateralPerfectionCapturePageDef.xml

Meta-
data
file
name

com\ofss\fc\ui\view\lcm\collaterals\collateralPerfectionCapture\
pageDefn\mdssys\cust\option\LZ\CollateralPerfectionCapturePageDef.xml.xml

Table 10–1 Path Structure
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(with
path)

For
Scree
ns

File
name
(with
path)

com/ofss/fc/ui/view/lcm/collaterals/collateralPerfectionCapture/form/CollateralPerfectionCaptur
e.jsff

Meta-
data
file
name
(with
path)

com\ofss\fc\ui\view\lcm\collaterals\collateralPerfectionCapture\form\mdssys\cust\option\LZ\Col
lateralPerfectionCapture.jsff.xml

Thesemeta-data sources are checked into theMETADATA folder in the product SVN under the localization
path. During deployment, the EAR implementing these customizations must include these abovementioned
sources in a .mar file.

10.3.2 .mar files Generated during Build
The localization specific build will include a last step, which is creation of .mar (metadata archive) file from the
files checked-in theMETADATA folder. This step will create separate .mar files, based on themodules which
these represent. TheseMAR files are then packaged inside the deployable application EAR
(com.ofss.fc.ui.view.ear).

Typical mar files generated during build will follow the naming convention
com.ofss.fc.lz.au.ui.view.<module>.mar. Example, com.ofss.fc.lz.au.ui.view.pc.mar

10.3.3 adf-config.xml
adf-config.xml stores design time configuration information. The cust-config section (under mds-config) in the
file contains a reference to the customization class. As part of the build activity, this file needs to be placed in
the path com.ofss.fc.ui.view.ear@/adf/META-INF/. Also the customization class should be available in the
classpath during deployment.

10.4 Packaging and Deployment of Localization Pack
In the OBP application, different projects will be shipped in the form of library jars which can be customized
and the new localization-specific application libraries can be created. In the application, the assembly has
been specifically modularized to take care of multiple localizations by prevention of mix-up of jars. The
naming convention for the jars can be defined for different clients differently.

The new customized jars for hosts and UI needs to be packed with the original jars in the EAR files which will
be deployed on the server. Let's say, we are creating the extension hooks of 'obp.host.app.domain' jar, then
the separate jars can be defined as 'lz.au.obp.host.app.domain' and 'lz.us.obp.host.app.domain' for Australia
and US respectively.

The similar structure can also bemaintained for the other applications across UI and SOA channels.
'lz.au.obp.ui.domain' can be defined for the customized jar of the project 'obp.ui.domain'.
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The new customized jars for hosts and UI are packed below with the original jars in the EAR files which will
be deployed on the servers.

Figure 10–19 Package Deployment
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